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How	to	measure	in	catia	v5

How	to	measure	a	tube's	bend	radius	on	an	isolated	body.	If	you	have	ever	worked	with	an	imported	geometry	of	a	tube,	you	probably	know,	that	CATIA	doesn't	provide	any	tool	to	measure	a	bend	radius.	If	there	is	no	centerline,	measuring	a	bend	radius	or	centerline	radius	requires	an	extra	geometry.	Our	target	is	to	create	an	UDF,	which	can	be
used	for	measuring	bend	radius,	center	line	radius	and	bend	angle	of	a	dead	geometry	of	a	tube.	1.	Let's	start	with	a	new	CATPart,	name	it	Bend	Radius.	Create	3	GeoSets,	name	them	Tube,	Inputs	and	Bend	Radius	Measuring.	2.	In	the	Tube	GeoSet	define	3	points	at	any	reasonable	coordinates.	Using	these	three	points	create	a	polyline	and	assign	a
radius	-	Fig.1.	Fig.1	3.	Now	create	a	swept	surface	along	the	polyline.	Profile	type	-	Circle,	Subtype	-	Center	and	radius,	assign	any	reasonable	radius,	in	my	case	it	is	10mm.	4.	Go	to	Input	GeoSet	and	Extract	two	edges	of	the	surface	like	it	is	shown	on	the	Fig.2.	Fig.2	5.	Isolate	the	two	extracted	edges.	Now	the	Inputs	GeoSet	should	contain	two
isolated	circles.	The	problem	is	that	sometimes	CATIA	may	not	recognize	these	edges	as	circles	on	imported	geometry,	therefore	it	is	better	to	use	any	curve	as	an	imput.	To	turn	the	two	circle	into	curves	use	Curve	Smooth	command	(Insert>Operations)	-	Fig.3.	Isolate	both	curves	and	delete	the	circles,	now	the	Inputs	should	contain	two	isolated
curves.	Fig.3	6.	Now	go	to	the	Bend	Radius	Measuring	and	create	a	new	GeoSet	in	it,	name	it	Curve	1.	Using	one	of	the	input,	create	a	point	on	curve,	see	more	details	on	Fig.4.	Fig.4	7.	Create	two	more	points	on	the	same	curve.	As	a	reference	use	the	point	from	the	previous	step.	Ratio	values	for	these	two	points	are	0.333	and	0.666.	Three
equispaced	points	have	been	created	on	the	curve.	Use	these	points	to	create	a	circle,	type	-	three	points,	circle	should	be	closed.	Using	this	circle	as	a	reference,	create	another	point,	type	Circle	/	Sphere	/	Elypse	center,	to	get	the	center	point	of	the	circle.	8.	Create	a	plane	using	three	equispaced	points	-	Fig.5.	Fig.5	9.	Use	this	plane	and	the	center
point	of	the	circle	to	create	a	new	line	-	Fig.6.	Fig.6	10.	Curve	1	GeoSet	is	ready	to	duplicate	it	(Fig.7).	To	duplicate	a	GeoSet	select	it	[1],	use	command	Duplicate	Geometrical	Set	[2],	in	the	new	window	choose	the	destination	[3],	then	select	the	second	curve	from	the	Inputs	GeoSet,	click	OK.	Name	the	new	GeoSet	-	Curve	2.	Fig.7	11.	Using	the	two
lines	create	a	plane	-	Fig.8.	Fig.8	12.	Use	this	plane,	center	point	and	line	from	Curve	1	GeoSet	to	create	another	line	-	Fig.9.	It	has	to	be	normal	to	the	line	form	Curve	1	GeoSet.	Create	a	line	in	the	same	way	for	the	second	curve.	Fig.9	13.	Intersection	of	these	two	lines	is	the	center	point	of	the	bend	radius	(yellow).	Name	this	point	-	Center	Point	-
Fig.10.	Fig.10	14.	Create	another	intersection,	like	it	is	shown	on	Fig.11.	Result	of	this	intersection	is	a	multiple	result,	it	means	it	has	more	than	one	solution.	In	Multi-Result	Management	window	select	option	-	keep	only	one	sub-element	using	a	Near.	As	a	reference	element	use	the	Center	Point.	Fig.11	15.	It	was	the	last	geometry	we	need.	Now
create	three	parameters	-	two	length	type	and	one	angle.	Drag&drop	them	to	the	Bend	Radius	Measuring	Geo	Set	-	Fig.12.	Fig.12	16.	Edit	their	properties	and	change	their	local	names	-	Fig.13.	Fig.13	17.	Next	step	is	to	create	formluas	for	these	parameters.	Add	a	formula	to	the	Bend	Angle	parameter	(Fig.14).	The	formula	measures	the	angle
between	two	lines.	Line.3	and	Line.4	are	the	yellow	lines	created	in	step	number	12.	Fig.14	18.	Formula	of	the	Bend	Radius	parameter	is	shown	of	Fig.15.	Fig.15	19.	Smilar	formula	has	to	be	created	for	the	last	parameter,	use	the	Center	Point	and	one	of	the	center	points	of	the	input	curves	-	Fig.16.	Fig.16	20.	New	formulas	have	been	created,
drag&drop	them	to	the	Bend	Radius	Measuring	Geo	Set	-	Fig.17.	Fig.17	21.	Hide	all	the	geometry	and	show	only	Center	Point,	Inputs	and	surface	of	the	tube	-	Fig.18.	Fig.18	22.	In	this	step	an	UDF	will	be	created,	go	to	Insert	>	Knowledge	Templates	>	User	Feature.	Select	the	Bend	Radius	Measuring	Geo	Set,	curve.1	and	curve.2	should	appear	in
Inputs	of	components	-	Fig.19.	Fig.19	23.	Go	to	the	Parameters	Tab	and	the	three	parameters	created	in	step	number	15.	Publish	these	parameters	and	modify	their	names	-	Fig.20.	Fig.20	24.Go	to	the	tab	Outputs	and	make	sure	that	the	main	result	is	the	Center	Point,	if	it	is	not,	replace	the	main	result	with	it	-	Fig.21.	You	can	also	go	to	the
Properties	tab	to	change	the	icon	of	this	UDF.	Click	OK.	Fig.21	25.	Save	the	file	and	close	it.	26.	To	use	the	UDF	create	a	new	file	and	another	tube	in	it.	Go	to	Insert®Instantiate	From	Document	and	select	the	CATPart	from	previous	point.		In	Insert	Object	window	choose	a	destination	and	as	an	input	select	two	curves	-	Fig.22.	Fig.22	27.	The	bend
has	been	measured	and	the	parameters	have	been	created	-	Fig.23.	Fig.23	Click	Measure	Between	.	In	DMU,	you	can	also	select	Analyze	>	Measure	Between	from	the	menu	bar.	The	Measure	Between	dialog	box	appears:	By	default:	For	reasons	of	legibility,	angles	between	lines	and/or	curves	equal	to	0	degrees	are	not	displayed	in	the	geometry	area
Minimum	distances	and	if	applicable,	angles	are	measured.	Measures	made	on	active	products	are	done	with	respect	to	the	product	axis	system.	Measures	made	on	active	parts	are	done	with	respect	to	the	part	axis	system.		Note:	This	last	distinction	is	not	valid	for	measures	made	before	Version	5	Release	8	Service	Pack	1	where	all	measures	are
made	with	respect	to	the	absolute	axis	system.		Select	the	desired	measure	type.	Notice	that	the	image	in	the	dialog	box	changes	depending	on	the	measure	type	selected.	Set	the	desired	calculation	mode	in	the	Calculation	mode	drop-down	list	box.	Click	to	select	a	surface,	edge	or	vertex,	or	an	entire	product	(selection	1).	Notes:	The	appearance	of
the	cursor	has	changed	to	assist	you.	Dynamic	highlighting	of	geometrical	entities	helps	you	locate	items	to	click	on.	Click	to	select	another	surface,	edge	or	vertex,	or	an	entire	product	(selection	2).	A	line	representing	the	minimum	distance	vector	is	drawn	between	the	selected	items	in	the	geometry	area.	Appropriate	distance	values	are	displayed	in
the	dialog	box.		Notes:	By	default,	the	overall	minimum	distance	and	angle,	if	any,	between	the	selected	items	are	given	in	the	Measure	Between	dialog	box.	For	more	detailed	information	about	the	dialog	box	options,	refer	to	More	About	the	Measure	Between	Dialog	Box	Measure	Item	is	accessible	from	the	Measure	Between	dialog	box.	In	DMU,	the
Measure	Thickness	command	is	also	accessible	from	the	Measure	Between	dialog	box.	For	more	information,	see	the	DMU	Space	Analysis	User's	Guide.	Select	another	selection	and,	if	desired,	selection	mode.	Set	the	Measure	type	to	Fan	to	fix	the	first	selection	so	that	you	can	always	measure	from	this	item.	Select	the	second	item	Select	another
item.	Click	Ok	when	done.	The	default	measurement	unit	that	comes	with	Catia	v5	is	in	milimeters	(mm)	and	the	spacing	for	the	grids	are	1	mm	for	major	grid	lines	(or	also	known	as	Primary	Spacing)	and	0.1	mm	for	minor	grid	lines	(or	Graduation).	However,	as	you	may	have	noticed,	the	Catia	v5	Tutorials	that	is	available	here	uses	inches	(in)	as
their	measurement	unit.	In	order	to	adjust	the	measurement	unit	to	the	one	that	you	desire,	all	you	have	to	do	is	to	access	the	Options	window	located	under	theTools	menu.	In	the	Options	window,	select	Parameters	and	Measure	which	in	located	on	theOptions	tree.	In	there,	select	the	Units	tab	and	you	will	be	presented	with	all	the	parameters
available	in	Catia	v5.	Select	the	parameter	that	you	want	to	adjust	and	for	this	tutorial	purpose,	we	will	be	changing	the	units	for	Length.	Once	you	have	selected	a	parameter,	you	can	change	its	units	by	using	the	drop	down	menu.	In	the	Sketcher	menu,	under	the	Mechanical	Design	tree,	you	can	adjust	the	Primary	Spacing	and	the	Graduation	values
to	suit	your	preference.	As	mentioned	earlier,	Primary	Spacing	is	basically	the	length	of	each	major	grid	lines	whileGraduation	is	the	spacing	between	minor	grid	lines.	As	you	can	see	below,	I	have	set	my	Primary	Spacing	to	1-inch	and	the	Graduation	to	10.	This	basically	means	that	the	length	of	my	major	grid	lines	will	be	1-inch	while	the	minor	grid
lines	are	0.1-inch.	In	this	article	I	will	show	you	how	to	create	bounding	box	in	CATIA	V5.	This	feature	is	very	useful	especially	in	the	case	if	it	is	a	part	that	has	a	complex	shape.	A	bounding	box	is	the	physical	shape	(that	you	run	into	or	that	other	physical	shapes	encounter)	for	a	given	object.	It	defines	the	physical	shape	of	an	object,	though	it	may	be
much	different	in	size	and	shape	than	the	objects	visual	appearance.	Open	the	given	object.	Select	the	part	body,	or	whole	part.	Then	click	on	the	Measure	Inertia	button	as	it’s	shown	on	the	picture	below.	Measure	inertia	window	will	open.	You	can	see	several	values	here.	However,	bounding	box	values	are	not	shown.	Therefore	click	on	the	button
customize	and	select	Principal	axes.	Close	windows	with	the	OK	buttons.	Then	go	to	the	part	(or	product)	tree	and	expand	item	Measure	and	Inertia	Volume	on	the	bottom.	There	you	can	find	three	values:	BBLX,	BBLY	and	BBLZ.	These	are	the	dimensions	of	the	desired	bounding	box.	As	you	might	have	noticed,	measure	inertia	window	offer	option	to
export	data	to	.txt	file.	It´s	button	beside	to	the	customize	button.	Finally	values	included	in	.txt	output:	Anyway,	it´s	up	to	you,	which	type	of	output	you	will	select.	In	conclusion	watch	the	video	for	better	understanding:	Insert	the	following	sample	model	files:	ATOMIZER.model,	BODY1.model,	BODY2.model,	LOCK.model,	NOZZLE1.model,
NOZZLE2.model,	REGULATION_COMMAND.model,	REGULATOR.model,	TRIGGER.model	and	VALVE.model.	They	are	to	be	found	in	the	online	documentation	file	tree	in	the	common	functionalities	samples	folder	cfysm/samples.		Learn	from	thousands	of	free	Tutorials	Join	the	Community	Surya	Mohan	Tyagi	There	is	a	toolbar	called	"measure"	which
can	measure	all	the	types	of	dimensions.	you	only	click	on	the	toolbar	and	then	select	the	surface	to	be	measured.	first	of	all	click	on	the	toolbar"measure	between".	then	select	the	geometry	which	is	to	be	measured.	for	radius	select	,measure	item	Community	Library	Challenges	Groups	Questions	Tutorials	Engineers	Workbench	Overview	Features
Compare	Shop	Overview	Features	Compare	Pricing	Resources	Blog	Resource	Center	Help	Center	©	2021	GrabCAD,	a	STRATASYS	solution	The	Computer-Aided	Design	("CAD")	files	and	all	associated	content	posted	to	this	website	are	created,	uploaded,	managed	and	owned	by	third	party	users.	Each	CAD	and	any	associated	text,	image	or	data	is	in
no	way	sponsored	by	or	affiliated	with	any	company,	organization	or	real-world	item,	product,	or	good	it	may	purport	to	portray.	who8myrice123	(Computer)	(OP)	7	Apr	15	15:41	Hey	guys,	new	here	in	the	forums.	Though	I'm	new	to	CATIA,	I	do	have	experience	in	NX9.	So	my	question	is:	how	would	I	measure	just	the	vertical	distance	between	two
features/points?	Whenever	I	try	to	take	a	measurement,	it	gives	me	the	diagonal	distance.	I	know	in	NX9,	there	is	a	tool	called	"Projected	Distance"	which	allows	you	measure	a	fixed	distance	depending	on	the	reference	vector.	Is	there	something	similar	here	in	CATIA?	Thanks	in	advance!	Thank	you	for	helping	keep	Eng-Tips	Forums	free	from
inappropriate	posts.The	Eng-Tips	staff	will	check	this	out	and	take	appropriate	action.	Page	2	Low-Volume	Rapid	Injection	Molding	With	3D	Printed	Molds	Learn	methods	and	guidelines	for	using	stereolithography	(SLA)	3D	printed	molds	in	the	injection	molding	process	to	lower	costs	and	lead	time.	Discover	how	this	hybrid	manufacturing	process
enables	on-demand	mold	fabrication	to	quickly	produce	small	batches	of	thermoplastic	parts.	Download	Now	Design	for	Additive	Manufacturing	(DfAM)	Examine	how	the	principles	of	DfAM	upend	many	of	the	long-standing	rules	around	manufacturability	-	allowing	engineers	and	designers	to	place	a	partâ€™s	function	at	the	center	of	their	design
considerations.	Download	Now	Industry	Perspective:	Education	and	Metal	3D	Printing	Metal	3D	printing	has	rapidly	emerged	as	a	key	technology	in	modern	design	and	manufacturing,	so	itâ€™s	critical	educational	institutions	include	it	in	their	curricula	to	avoid	leaving	students	at	a	disadvantage	as	they	enter	the	workforce.	Download	Now	Taking
Control	of	Engineering	Documents	This	ebook	covers	tips	for	creating	and	managing	workflows,	security	best	practices	and	protection	of	intellectual	property,	Cloud	vs.	on-premise	software	solutions,	CAD	file	management,	compliance,	and	more.	Download	Now	Something	went	wrong.	Wait	a	moment	and	try	again.	When	measuring	a	part	using	the
"Measure	Between"	or	"Measure	Tool"	to	measure	a	part,	is	there	a	way	to	sum	all	of	the	measurements	taken?	I	am	trying	to	measure	an	assembly	with	complex	curvature	along	it's	edges	but	I	am	faced	with	adding	all	the	edge	measurements	together	in	excel	to	get	it's	length.	Is	there	way	around	this?	Is	there	a	Macro	for	this?Page	2Posted	by4
years	ago	6	comments	WARNING:	This	will	only	work	if	any	other	screen	sizing	variable	has	been	disabled!	E.g.	CATForceVideoSize	In	order	to	calibrate	our	display,	you	will	need	to	set	two	windows	environment	variables;	CATWidthMMOfScreen	and	CATHeightMMOfScreen.	The	variables	that	you	will	need	to	measure	are	the	screen	width	in
millimetres	and	the	screen	height	in	millimetres.	e.g.	My	monitor	screen	has	a	width	of	595mm	and	a	height	of	345mm.	1)	Set	the	Environment	Variables	in	windows:	a)	Select	the	START	button	on	the	taskbar	and	right	click	on	COMPUTER	and	select	PROPERTIES:	b)	Select	ADVANCED	SYSTEM	SETTINGS	c)	In	the	SYSTEM	PROPERTIES	dialog	box,
ADVANCED	tab,	select	ENVIRONMENT	VARIABLES:	d)	Select	NEW…	in	the	ENVIRONMENT	VARIABLES	dialog	box:	e)	Enter	two	new	variables;	CATWidthMMOfScreen	and	CATHeightMMOfScreen	with	values	corresponding	to	your	monitor	screen	width	and	height:	f)	Press	OK	and	close	all	dialog	boxes.	2)	Launch	CATIA	V5	a)	Either	open	an
existing	component	(Part/Product)	or	create	a	new	component:	b)	Run	command	“C:	SCALE	PLANES”:	c)	The	SCALE	PLANES	PROPERTIES	dialog	box	will	inherit	the	WIDTH	and	HEIGHT	from	the	environment	variable	set	in	1).	These	can	be	left	as	default	then	press	OK.	d)	Set	a	standard	view	e.g.	Front/Top/Etc	and	using	a	ruler	directly	measure
from	your	monitor	screen	for	exact	measurements.	e)	To	turn	off	the	screen	scaling,	simply	run	the	same	command	from	step	2b)	again.
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